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latest inkjet printing developments
to be presented by klassic specialties

Kay and Don Baker of Klassic Specialties e are extremely pleased to welcome Don
i and Kay Baker from Klassic Specialties

who will present the “Latest Printing De-

velopments” at our October 8 meeting.

The Bakers will explain the current development
trends and marketing scenarios of several printer
manufacturers, and tell us how the changes will be
affecting customers like us.

They will also give us an overview of digital print-
ing techniques and technologies, which include laser
printers, thermal bubblejet inkjets, and Piezo-electric
inkjets; also we’ll learn about ink alternatives such as
continuous ink systems.

Finally, they will explain how to select media for

your inkjet printers — what you should look for in
. photo papers and how they differ. They will show us
' samples of some of the results from using different
types of paper.
Don is well-known among computer user
groups and has made more than 300 pre-
sentations to groups in California, Arizona,
Nevada, and Oregon. Many of you may
. have met him at the Southwest Comput-
er Users Conference in San Diego.
Klassic Specialties is based in Cerritos
and carries quality imaging products for
inkjet printing, such as ink, paper, toner and
related;printing supplies. Besides other events,
Klassic iSpecialties has supplied products for the

ecause he is recovering from a broken
\ k

Jplease be sure to attend this superb
ation — and invite a friend to come

s to Lothar Loehr, Program Chairman
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DIGITAL PHOTOGRAPHY

Didn’t take long until the hummingbird feeder was empty. [ wonder why they all crowded around the one
spigot. Maybe there was a queen underneath all that commotion. Or a yellow jacket pop idol?

[ am glad they really were bees. After they flew away I have seen hardly any bees any more. They may have
found a place to set up housekeeping, or whatever bees do.

Right now the feeders only need refilling once a week or so, especially in the absence of bees. But soon the
humming birds will be starting to fill up in preparation for their long fall migration. Last year around late Sep-
tember I had as many as 8 or 10 humming birds fighting each other for access, and then the sugar goes fast!

Photo by Pim Borman, Evansville, Indiana
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LoTHAR LOEHR
ProGRAM CHAIRMAN
ORCOPUG

It was a great pleasure to have
you as our speaker last night.
The presentation was very inter-
esting and scary and we could
have all listened to you much
longer, but we knew you had to
get your dinner at home.

The best sign how to rate the
interest of a presentation is that
nobody fell asleep and the interest
did not stop.

One question came up after
you left: Why are there more
women involved in such large
crimes than men? Most cases you
had were done by females, why?

Thank you again.

MARrc G. LABRECHE
Sr. DpT1Y. DISTRICT ATTORNEY
ORrRANGE County DA’s OFFICE

hank you

again for invit-
ing me to speak
to your group.
The running joke
around the office is
that I only pros-
ecute women in
their 50’s.

Why they com-

mit more em-
bezzlements would

probably be a great

subject for someone to write their
PHd thesis on.

GENE BArRLOW
UsER GROUP RELATIONS

Acronis recently announced the
Acronis True Image 2014 product.
This new version focuses on the
Acronis Cloud backup facility.
With this new release, you can
backup your entire main hard
drive including Windows and
your application programs to the
Acronis Cloud and not just a few
of your data files.

You will also receive a free
one year use of the Acronis Cloud
storage space (5GB) to try out the
new Acronis Cloud facilities. This
space also gives you free Data
Synchronization with your mobile

devices and your main computer.

You can order your Acronis
products from us at great dis-
counts prices. We also provide
added support you will not get
from Acronis or elsewhere.

To order either Acronis True
Image 2014 or Acronis Disk Direc-
tor 11 Home, just go to http://www.
ugr.com and click on the product
package you wish to purchase.

We offer single licenses at $25
and a Family Pack with 3 licenses
for just $60. When completing
your order enter the order code of
UGNLog13. If you have problems
ordering contact me at support@
ugr.com and [ will assist you.

(Please support Gene Barlow.
He’s been a generous and loyal
supporter of our user group. —LG)

DARRY D EGGLESTON
RIVERVIEW, FLORIDA

IVl y friend, Dave Lee,
sent this note and
photo: “Life Hacks: I can
use all the help I can

get. I think this one is

my favorite: It would also
work for watching football
because I like to wave

my arms and shout at

the coaches and players.
The pancake batter in a
ketchup bottle (idea) also
caught my attention.”
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embedding true type fonts

by Allen Wyatt

f you create a document that you want to share

with others, it is helpful for the other people to

have the fonts you use within your document.

If they don’t have the fonts, then Word substi-
tutes a similar font for the original fonts you used.
The result may not be to your liking. One solution
is to include the fonts with your document. You can
automatically embed some types of fonts by following
these steps:

1. Choose Options from the Tools menu. Word
displays the Options dialog box.

2. Make sure the Save tab is selected. (Figure 1.)
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Figure 1. The Save tab of the Options dialog box.

3. Ensure the Embed TrueType Fonts check box
is selected.

4. Ifyou will be using a small number of charac-
ters in a particular font, choose the Embed Charac-
ters In Use Only check box.

5. 'To save space in the document, choose the Do
Not Embed Common System Fonts check box.

6. Click on OK.

7. Work with your documents as normal.

You should realize that embedding fonts can
increase the size of your document files. In fact, if you
use a lot of fonts, it can increase the size drastically. In
addition, not all fonts are “embeddable.” Some fonts
are protected by their creators against distribution by
embedding. If you are curious about whether a par-
ticular font can be embedded, you can either contact
the vendor or download a free Font Properties Exten-
sion Tool from Microsoft. You can download it at the
following address:

http://www.microsoft.com/typography/ITrueTypeP-
roperty21.mspx

The tool updates Windows so it displays more
information when you right-click on a font file and
choose Properties. One of the pieces of information
displayed is whether the font is protected or not. If it
is protected, it cannot be embedded in a Word docu-
ment.

WordTips is your source for cost-effective Micro-
soft Word training. This tip applies to Microsoft Word
versions: 97, 2000, 2002 and 2003 and is at http://word.
tips.net/T'ooos58_Embedding_TrueType_Fonts.html

You can find a version of this tip for the ribbon
interface of Word (Word 2007 and later) at http://
wordribbon.tips.net/T'003589_Embedding_Tru-
eType_Fonts.html

Copyright © 2013 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Word tips can be found online at http://word.tips.net
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specifying the behavior of the enter key

by Allen Wyatt
en you type information into a cell, it want the selection to move or not when pressing
is normal to press the Enter key at the Enter.
end of your entry. Excel allows you to 4. If you select the Move Selection After Enter

specify exactly what should happen after you press ~ check box, use the Direction drop-down list to
Enter. specify the direction of the cell that should be
Basically, you can specify that nothing happen selected.

(the cell into which you entered information 5. Click on OK.
remains the currently selected cell) or that a ExcelTips is your source for cost-effective
different, adjacent cell is automatically selected. Microsoft Excel training. This tip, at http://excel.
To make your specification, follow these steps: tips.net/T'0o2975_Specifying_the_Behavior_of_
1. Choose Options from the Tools menu. the_Enter_Key.html, applies to Microsoft Excel
Excel displays the Options dialog box. versions: 97, 2000, 2002 and 2003.
2. Make sure the Edit tab is selected. (See You can find a version of this tip for the ribbon
Figure 1.) interface of Excel (Excel 2007 and later) at http://
3. Either select or clear the Move Selection excelribbon.tips.net/Too8848_Specifying_the_

After Enter check box, depending on whether you Behavior_of_the_Enter_Key.html
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Figure 1. The Edit tab of the Options dialog box.

Copyright © 2013 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found online at http://excel.tips.net
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COMPUTER HELP

Question: My eyesight is failing and I find it very difficult to enlarge

the font in order to read my email online. Is there another way?

ask pamel

by pamela tabak

nswer: Yes, you can easily ENLARGE the font in
Ain online email as follows: Hold down the C'TRL
ey and scroll with the mouse wheel. This works
on most websites and other software as well.

Question: When typing the temperature I would like

to insert a “degree” symbol automatically instead of

writing the word “degrees.” Is there a shortcut for this
symbol?

Answer: Yes, there are two shortcuts for the degree
symbol.

1. Hold down the ALT key and type 0176 on the
numeric keyboard. The degree symbol will appear
immediately © You must use the numeric keypad to type
the numbers and not the keyboard. Make sure that the
NUM LOCK key is on if your keyboard requires it to type
numbers on the numeric keypad.

2. AutoCorrect has a predefined keyboard shortcut

=

=
4
L
[l

SDHHQ_H-,,:,..-

HOCI® cpavn

ﬂ\l | B

for creating a degree symbol. Press CTRL+@, then press
SPACEBAR.

Question: When I am typing an email or a document in
Word on my laptop my mouse jumps to another line and
I find myself typing in the middle of another sentence.
Why does this happen and can it be corrected?

Answer: When using a notebook with a touchpad and

a mouse attached, your thumb may get too close to the
sensitive touchpad. This will cause the insertion point to
jump to another line.

To prevent this you can disable the touchpad in
Control Panel > Mouse > Touchpad tab, and just use the
mouse. If you prefer to use the touchpad, look for a setting
on the Touchpad tab to make it less sensitive.

Used with permission. For more questions and

answers check the ComputerTutor’s site at http://www.
computertutorinc.net/frequently-asked-questions-2/
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free utilities to boot and repair “crashed” pcs

by Ira Wilsker

ne day last week I received

a phone call from a promi-

nent media personality
asking for help; his Windows 7 com-
puter would not fully boot into either
normal Windows mode or safe mode.
During the boot process it would ei-
ther spontaneously reboot before the
desktop loaded, or would start to boot
when the infamous “Blue Screen of
Death” flashed on for just a second
or two, and then the computer would
self-reboot, and fail again.

[ went to his house and found

that he had a custom built Windows
7-64 “Professional” machine that was

assembled for him by a major local
computer store. The machine was
about three years old, and had been
problem free until this incident oc-
curred.

My first steps in trying to get his
computer to boot was to carefully ob-
serve his boot process, trying to read
the error codes on the “Blue Screen”
before they flashed off. After several
reboots, I noticed that the error codes
were inconsistent, as they were differ-
ent with each reboot.

After several unsuccessful at-
tempts to boot into safe mode, trying
safe mode by itself, safe mode with
networking, and safe mode com-

8 ORANGE COUNTY PC USERS GROUP — OCTOBER 2011

mand prompt,

[ finally was able to boot once
into regular safe mode. I asked him
if he had installed any new software
or hardware recently prior to this
problem, and he said no. I went to
System Restore and found a restore
point from a few days prior to this
boot problem, checked the utility to
see if any files were in jeopardy (none
were), and ran the system restore.
The process appeared to complete
successfully, and rebooted the com-
puter, but the problem continued; it
was in an “infinite loop” of boot —

reboot.
Turn to next page



[ tried several times again to
boot into safe mode (F8), with only
temporary success. [ tried to check
his startup using MSCONFIG, but
the computer often self-booted too
quickly to accomplish the task; after
about the fifth attempt, I was able to
uncheck everything unnecessary and
save the revised startup settings just
before the computer rebooted itself
again.

Fully aware that if it was a mal-
ware problem that had impacted his
startup process, the malware might
not show up in the startup listing. |
inquired as to the security system that

he had installed on the computer;
he replied with the name of a ma-
jor, very popular, freeware antivirus
product. I inquired if it was just the
antivirus utility or the entire security
suite, and he informed me that it was
just the antivirus product.

Now I became even more suspi-
cious of the cause of his boot prob-
lem, as viruses are now only a small
minority of contemporary malware
threats, and traditional antivirus soft-
ware, even when frequently updated,
may not provide any protection from
the myriad of threats being widely
circulated.

How o create a bootable AVG Rescue COMUUSE | AVMG Tutonal
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IRA WILSKER - RESCUE UTILITIES

[ proceeded to boot his computer
using a bootable CD that I had with
me so | could backup his critical
personal files to his external USB
hard drive using the included backup
utility, and then run several repair
utilities that have worked well in the
past to boot previously unbootable
computers. The bootable CD that
[ had with me was a well regarded
commercial product (not freeware)
that had been recently sent to me for
review and testing.

Despite running each of the
included utilities, followed by an

Turn to next page

Video tutorial, “How to create a bootable AVG Rescue CD/USB,” is at http://
www.youtube.com/watch?v=meCZfrvE1gg
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IRA WILSKER - RESCUE UTILITIES

what the experts say

“The AVG Rescue CD enables you to fully remove infections from

an otherwise inoperable PC and render the system bootable again
... This could also be handy for folks who locked out of their PCs

by faulty updates ...”

Gizmo’s Freeware

“Trying to cure an already infected PC is quite literally like trying

to close the barn door after the horses have run out. Fortunately,

there’s a new weapon at your disposal: AVG Rescue CD ... it’s

something every user should keep in his or her toolkit.”
BNET

“AVG Rescue CD proves that sometimes the best things in life

can be free.”

About.com

“Ideal for when the effects of the virus is preventing the operating

system from booting.”

Technibble Repair Tool of the Week

on-screen confirmation that they
appeared to be successful making
changes to his hard drive and critical
system files, his computer still would
not successfully reboot. Stymied, |
offered to return with some addi-
tional utilities.

There are some excellent free-
ware utilities that can be used to cre-
ate bootable CDs (and in some cases
bootable USB drives), and contain
a wide variety of repair and recovery
utilities.

Since they are frequently updat-
ed, I chose to download and create
fresh CDs of each, rather than use
the older CDs that I already had.
While most of the computer security
software publishers, such as Trend-

Micro (TrendMicro Rescue Disk)
and Kaspersky (Kaspersky Rescue
Disk 10), offer a free downloadable
utility to create a bootable CD that
can detect and clean a malware
infected computer, a process that is
often adequate to enable a heavily
infected computer to successfully
reboot, my personal preference is
for a bootable CD that can scan for
malware as well as offer additional
repair utilities that may be useful in
repairing damage caused by malware
or other issues.

My preference is to create
bootable CDs rather than bootable
USB drives because virtually any CD
drive equipped PC can be booted
with a CD, but only some of the
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newer PCs support booting from a
USB drive.

While I commonly create four or
five different bootable CDs in order
to deal with almost any reasonable
contingency, there are two that are
my primary “go to” CDs. In the event
that there might be a malware prob-
lem influencing a boot problem, my
personal choice is the AVG Rescue
CD (avg.com/us-en/avg-rescue-cd), a
106MB download that is an ISO for-
matted file. ISO files cannot simply
be burned or copied to a CD to make
it bootable, but must be created using
the ISO function included on most
CD burning utilities, or by using the
excellent free ImgBurn utility (img-
burn.com) which will quickly and
easily utilize the ISO file to create a
bootable CD.

For those who may prefer a
bootable USB drive, a version of
AVG Rescue is available that can be
used to create a bootable USB drive;
for either choice, AVG offers a You-
Tube with simple instruction on how
to use the Rescue service at youtu.be/
tGX-592qty8.

Once the bootable device, CD
or USB is created, the computer
is booted with that device; some
computers may need to be set in the
BIOS or boot selection choices in
order to boot from the chosen device.
Once booted using the Rescue CD
or USB, a license agreement will be
displayed, all hard drives mounted
(become accessible), and the AVG
will go online in order to download
any updates.

Atfter following the on-screen
prompts (it may be necessary to use

the cursor keys, up, down, right, or
Turn to next page



Uitirmate Boot CD W 2.6

GRUB4DOS reenu

http:srmmm ultinatebooted. con

Fl for more inforasat ion
46 )

Video tutorial created by an Ultimate CD user: Boot the Ultimate Boot
CD as an ISO file from a USB flash pen drive http://www.youtube.com/
watch?v=wX6BHneflms

left), the hard drives can be scanned
and the detected malware removed,
renamed (typically prevents it from
reloading), or ignored. After the suc-
cessful removal of malware, return
to the main menu and select the
“Miscellaneous Utilities” if desired;
these miscellaneous utilities include
a selection of diagnostic programs,
file management tools, troubleshoot-
ing programs, and repair tools.

In my experience, this AVG Res-
cue CD (or Rescue USB) is typically
adequate to clean an infected PC
from malware and restore it to operat-
ing condition.

For someone that wants “every-
thing including the kitchen sink”,
there is an incredibly powerful free
utility “Ultimate Boot CD” (ultimate-
bootcd.com) that may create what
is generally accepted as the most
comprehensive set of free repair and
recovery tools available on any free
bootable CD. A huge download, a
561MB ISO file, this file can be used

to create a bootable CD using Img-
Burn or the ISO function available in
most CD burning utilities.

For those who prefer creating and

using a bootable USB drive, detailed

http://www.avg.com/us-en/avg-
rescue-cd

http://youtu.be/fGX-592qty8 (Video
on AVG Rescue CD or USB)

http://www.ultimatebootcd.com/
index.htm|

http://partedmagic.com/doku.
php?id=programs

http://www.techsupportalert.com/
content/probably-best-free-security-
list-world.htm?page=0,20

http://support.kaspersky.com/viruses/
rescuedisk?level=2

http://esupport.trendmicro.com/
solution/en-us/1059379.aspx

http://www.imgburn.com

IRA WILSKER - RESCUE UTILITIES

instructions are found under the
heading “Making UBCD memory
stick” online at ultimatebootcd.com/
customize.html.

What is so amazing about this
“Ultimate Boot CD” is the enormous
selection of over 100 diagnostic and
repair programs that are included on
this CD (or USB drive).

When I first boot with the Ulti-
mate Boot CD, I typically perform
a malware scan using the included
F-PROT and ClamScan security
software, cleaning any detected mal-
ware, and then using any necessary
additional utilities to accomplish my
task of repairing the computer, unless
the problem is primarily a hardware
problem and not a software problem.

While there are often multiple
utilities on the Ultimate Boot CD
that can perform the same basic
functions, the included utilities can
be used to reset the BIOS, clean the
CMOS, test the CPU chips, examine
and repair the master boot record
(MBR) and other bootable sectors
of the hard drive, reset system pass-
words, edit and repair the registry,
diagnose and manage the hard drives
(both generic and brand specific),
copy or clone the hard drive, edit or
wipe the contents of the disk, install
a new hard drive (both generic and
brand specific), repair or reset a hard
drive partition, test the PC’s memory,
scan for malware using multiple
anti-malware programs, test the video
card and other peripherals, test over-
all system performance, and generate
detailed reports about the computer’s
hardware.

Included on the Ultimate Boot
Turn to next page
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IRA WILSKER - RESCUE UTILITIES

Parted Magjic
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CD is a huge collection of over

100 additional utilities included

in the “Parted Magic” collection.
This “Parted Magic” group of
utilities (partedmagic.com/doku.
php?id=programs) provide extensive
extra functionality including hard
drive utilities, file system tools, boot
loaders, dozens of practical utilities
(X Utilities) that enable traditional
computer functionality without Win-
dows being loaded, and dozens more
“Console Utilities” that offer the user
the ability to perform other diagnostic
and repair functions.

Qnitprogs - 1ok for doing neal things with NTFS
Oy FS o FIHSFE hocsd filsavaiam neinn Oihea® TR

I have found Ultimate Boot CD
to be a most valuable and useful tool
in diagnosing and repairing problem
computers, and the AVG Rescue CD
an effective bootable CD in clean-
ing the malware from badly infected
computers and restoring the com-
puter to full functionality.

With both of these free bootable
CDs (or bootable USB drives), any
technically competent user can easily
diagnose and repair most software
related problems that may have previ-
ously rendered a PC un-bootable.

12 ORANGE COUNTY PC USERS GROUP — OCTOBER 2011

Read Ira Wilsker's
weekly
computer
and
technology
column

in the
Examiner at
http://www.
theexaminer.com/
feature/ira-wilsker
You can email Ira at
iwilsker@sbcglobal.
net.




by Bill Sheff, LVCG

Icd resolutions
CD monitors are super. They're flatter, lighter, and let’s face it, cooler than the bulky old CRT's

out there. However, unlike CRTs, LCDs look their sharpest at their native resolutions, such as

1,280 x 960 or 1,600 x 1,200 pixels, as listed in their users’ manuals. If you have your computer’s
display settings set to a different resolution, onscreen text and graphics may appear slightly fuzzy. On
the other hand, the native resolution may be so fine relative to the physical size of the screen that
onscreen objects may be way too small for your tastes. If the labels of your icons are too tiny to read at
the LCD’s native resolution, try lower settings until you find a resolution that’s reasonably sharp. If you
are the market for a new monitor, look around for a touch screen which will make you ready for Win 8

when you get it.

adjust monitor brightness

Since we are on monitors let me ask: Do your eyes hurt after sitting at your computer, it may not just
be from spending too much time staring at your screen. An overly bright monitor (particularly in a dark
room) can be uncomfortable for some users. Check your monitor’s sides and bottom (of the screen,

rather than the stand) for buttons that will let you lower the display’s brightness setting.
Turn to next page
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COMPUTER TIPS

log out quickly

If you regularly log out of your Windows
XP/Vista computer instead of shutting it
down, try this handy key combination to
quickly switch user accounts or “lock” your
computer, depending upon your security
settings. Press the Windows key (next to
the ALT key on many keyboards) and L at
the same time. You'll still be logged on, but
you’ll be able to switch user accounts. If
your account requires a password, your PC
will be “locked” until you supply it. When
you return to the same account, you'll see
the same documents and applications that
were open before you pressed Windows-L.

wep and wpa

You probably already know that you shouldn’t set up a
WLAN (wireless local-area network) or Internet connec-
tion without protection in the form of encryption. What
you may not realize is that WEP (Wired Equivalent Pri-
vacy) encryption is no longer enough in the eyes of most
experts. WEP may discourage casual attempts to connect
by nearby users that detect your WLAN’s presence, but it
won’t keep out skilled and determined hackers. A bet-
ter choice is WPA (Wi-Fi Protected Access), which adds
several layers of protection beyond WEP. To use it though,
youll need WPA support in both your router or access
point and your computer’s wireless adapter.

convert to print or web

Microsoft Publisher’s Convert To Print and Convert To
Web Publication options let you change a print publi-
cation to a Web publication and vice versa. Open the
publication you want to convert and click File. Next,

click either Convert to Web Publication or Convert to
Print Publication and follow the instructions to make the
switch. As a word of caution, certain features available in
one publication type may not be available in the other, so
your publication may experience a few formatting changes
when you convert it.
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take a screenshot in word
Microsoft Word 2010 provides you with the capability

to take a screenshot from another open program and
paste it within Word. Just click the Insert tab and select
Screenshot.

gadwin screen capture

Since I mentioned the Word 2010 screenshot capability, 1
thought I would mention Gadwin Screen Capture. This is
a free download (just Google Gadwin) and allows you to
take a screenshot of a window at any time. You can be on
the internet, browsing a PowerPoint presentation or any
time you want to capture something on the screen. Once
loaded it works when you hit the printScrn button. (I
think the latest version has you hold down the Control key
at the same time). You can set up the name of the capture
and whether you want to capture it to the clip board or to
a PrintScreen folder, or both. What you end up with is a
jpg or bmp picture. If you take a picture of a document
you can always use a free OCR program to convert it to
actual text. One thing you must do is set it for ‘rectangle’
while you are setting it up. This way you can capture any
size portion of the screen — from full monitor to a small
rectangle containing just what you need. I know there are
Turn to next page



other screen capture programs out there, but I have been
using this one for many years and it works simply and flaw-
lessly.

background removal tool

Need to quickly remove the background from an image?
With the Background Removal Tool in Microsoft Word
2010, you can clean up the background to make your
image blend with the document.

recall a message in outlook

Catch a spelling error right as you were sending out an

~ Go incogiiifo to prevent
anyone seeing your
browsing history.

COMPUTER TIPS

email? If you are using Microsoft Outlook, you can recall
the message. Open your sent messages, open the email
you want to recall, select Actions (located in the Move
section of the ribbon), and click Recall This Message.

put recent items on the start menu

Windows 7 has a Recent Items feature, which can display
any documents you've recently used. To put this button
on your Start Menu, click Start and then right-click the
Start menu. Click Properties. When the Taskbar And Start
Menu Properties window opens, click the Start Menu tab
and then click the Customize button. When the Custom-
ize Start Menu button opens, scroll down to Recent Items
and check its box. Click the OK button. Click the OK
button on the Taskbar And Start Menu Properties
window. Now, click the Start button. You'll see the
Recent Items button on the right side of the Start
Menu. Hover the mouse over Recent Items (or click
it) and you'll see

the list of recently used documents. Click any
document in the list to open that item.

go incognito

If you are using a friend’s computer and don’t want
your browsing history to remain on his PC after you
leave, you might want to use Chrome’s Incognito
window. It prevents the PC from retaining most
traces of your browsing. (It won’t, however, prevent
a keystroke capture device from tracking your key-
strokes.) To use the feature, click the wrench icon
and then click New Incognito Window.

Bill Sheff is a SIG Coordinator for novice
computer users in the Lehigh Valley
Computer Group, in Pennsylvania —
https://sites.google.com/site/lvcgsite/. Bill’s
article was in the April 2013 issue of the
LVCG Journal. You can email him at
Nsheff@aol.com.
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green bars

I\/l local advisor tells me | have a virus in my BIOS, which cannot be removed;

at least, not by Norton. Proof of the virus, he insists, is that | have two green
columns in the dialog box of my disc defragmenter. He further insists that the green will
continue to expand until my PC fails completely.

A second advisor insisted the second green column could be eliminated by going to
Systems, Performance, Virtual Memory and clicking “No page file.” | tried several times. As
soon as | restore the page file, the second green column reappears. Then, he suggested
Page Dfrag.zip. It also failed to eliminate the second green column.

At that point, his confidence failed and he too leaned to the virus as the most probable
explanation. Is this a situation which should worry me? My PC is five years old and is
running fine. | have Norton 360 v4 on Windows XP. My C: drive has 290 GB cap and 280
GB free space at present.

Turn to next page
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are normal and expected. They don’t indicate a virus at

Ithillk it’s time to find new advisors. Those green bars

all, BIOS or otherwise. And the advisor who suggested
that they do is just plain wrong. I'll show you what they do
indicate.

green bars

To make sure that we're all talking about the same
thing, here’s an example of green bars in the Windows XP
defragging program:

L]

- Dk D apmenter
Fis  Aich  View Hb
&2 @

Lo

COMPUTER HELP

Sure, removing your paging file may well make some
of the green bars go away. By not having a paging file at
all, there’s nothing for Windows to lock. But that’s rarely
the correct solution. Most machines need a paging file
configured to run properly.

Besides, getting rid of green bars isn’t really a useful
goal. As I said, they just represent a few files which the

defragger can’t move.
That's OK.

page defrag

Running Page Defrag could certainly reduce
the number of green bars. It does so by defragging
the paging file and other files before Windows

Seeany Statun Fily Srslom ety Froo Soaoe

= MNOTENPYM (C:)
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actually runs.
Remember that defragging is all about taking
the various parts of a file that might be scattered

Extimatest dhk uagn bedore defragrmntation:

W JNRARNO

Fstimated dabl usage alfer delliagmeristion:

LI

all over your hard disk and moving those parts
so that they are all right next to each other. This
helps speed up disk access.

Defragging the paging file might move two

or more of those green bars next to each other so

() (ot |

W Fraperied fles W Cortiguos fes [ Ureneecntin e [ Froe spuace

that they then appear as a slightly larger single
green bar.
That’s all.

This happens to show one large bar, but, in fact, it
could be several green bars or lines throughout the display.

Green lines do not indicate a virus.

Period.

As the legend at the bottom of that very window tells
you, the green bars indicate “Unmovable files;” nothing
more, nothing less.

unmovable files

So, what’s an unmovable file?

Well, your second advisor was at least on the right track.
Unmovable files include things like the system paging
or virtual memory file, the registry and other files that
Windows has locked for exclusive use while it’s running. If
Windows has them locked, then the defragging utility can’t
defrag them.

what about a bios virus?

A BIOS virus is highly unlikely.

BIOS viruses exist, but theyre very rare. They’re not of
great value to hackers who can typically infect many more
machines with much less work using a more traditional
virus.

At this point, I'm afraid that I can’t trust the judgment
of your first advisor who seemed to think you have a virus
simply because the defragger showed some unmovable
files.

As I've said, they’re completely unrelated.

Used with permission of

Leo A. Notenboom, Ask
Leo! http://ask-leo.com.

Source: http://ask-leo.com/do_green_bars_in_the_
defragger_mean_my_bios_has_a_virus.html
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SOFTWARE REVIEW

What did | do
without
this program?

Oh yeah. | used
Notepad.

This is
Wwaaay
easier!

by Linda Gonse

t’'s probably safe to say

that everyone has copied

text from a webpage at
some time and pasted it into
an email or into a Word-like
program. So, of course, you can re-
late to my dismay of pasting the type
complete with its formatting riding
piggyback on it.

[ always have to stop what I'm
doing and unformat and reformat the
type, so it blends in with what I'm
working on.

[ can hear “old timers” yelling,
“Notepad! Use Notepad!”

That’s true. And, it’s a good op-
tion. 'm using Windows XP (still), so
[ have a shortcut to Notepad on my
Start menu. It’s very easy to click on
Start while I have my browser open
and click to open Notepad to paste
the web text, then recopy it from
Notepad, and repaste the text into a
document.

But, I found a simpler method.

Really. There is no learning curve.

[ only have to click once after

copying from a webpage and then [
can immediately paste unformatted
text into anything anywhere!

With our typical complicated pro-
grams to work with, this just doesn’t
seem possible. Or, maybe alchemy
might be involved!

The short of it is that this is true,
no hocus pocus. It is possible with a
tiny program called Get Plain Text.

It’s only 70Kb and it doesn’t add
an icon to your system tray or grab
any memory when you use it.

It works in less than a second to
remove text formatting, including
fonts, sizes, colors, and embedded
images. It just leaves plain text.

Download the program from the
developer at http://clipdiary.com/
getplaintext/?s=internetshortcut&
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utm_nooverride=1 or a secondary
download site at http://www.softpedia.
com/get/PORTABLE-SOFTWARE/
Office/Clipboard/Portable-Get-Plain-
Text.shtml. Save it to your preferred
disk location. Click on the program
to run it. Add the icon that launches
Get Plain Text to your Quick Launch
bar or favorite program launcher.

[ keep it on my Quick Launch
bar. As soon as I copy something
to the clipboard, I click on the Get
Plain Text icon. Then, I paste the text
anywhere [ desire. That’s it.

When [ use Get Plain Text, no
window opens. There are no dialog
boxes or preferences to select. There
are no flags, bells, or whistles to tell
me it is finished. It simply works fast,
silently, and unobtrusively.

Did I mention — it’s free!



september keyword explained

strobist.com - lighting 101

by Mike Lyons
It’s been quite a while since I mentioned one of the best photo education
sites on the web — Strobist.com.

Started in March 2006, David Hobby created a lighting tutorial to help
beginning photo students learn flash photography with a minimum of equip-
ment. What is really cool is he explains in understandable terms and gives you
his thoughts behind the instructions.

Between 2006 and 2013, David learned a lot about lighting and how to do
things better. In addition, lighting equipment and lighting styles have evolved.
David has just completed a rewrite of Lighting 101, called Lighting 102.

If you haven'’t read Lighting 101, I'd start there and move onto Lighting 102
(although you don’t have to).

He also has a bunch of behind the scene shots with his thought process
included. It's another great resource on the site.

I I This website is about
one ’[hing: Learn-

ing how to use off-

camera flash with
your DSLR to take
your photos to the
next level. Or the
next ten levels.

If you are a complete

beginner at lighting, you

are in the right place.
Strobist’s Free Light-
ing 101 course starts from absolute zero. Over four million photographers from all
around the world have taken the plunge before you. Come on in, the water’s fine.

You probably already have most of what you need to start creating kickass photos
with your own small flash, and all of the information on this site is
free. We talk about the big lights, too. But your small flashes
are the perfect starting point - small, simple and cheap.

As you read through Lighting 101 you'll learn how to
control every aspect of your electronic flash. You'll learn
how to take the removable flash that you probably al-
ready have on the top of your camera and use it off-cam-
era to make beautiful, more three-dimensional photos.
http://strobist.blogspot.com/z006/03/lighting-101. html



INTERNET

the jeopardy answer is...what?

by Linda Gonse

he final question on Jeopardy on its September 26 episode was based
on the category “Internet.” The question was “T'he animal for which
this computer program is named is actually a red panda.”

Do you have any idea what that program is? When I tell you the answer,
you will shake your head — as I did — and you will say “What? That’s not
right!” — just as I did.

Are you ready? The answer is “What is Firefox (the internet browser)?”

“Fire fox,” in Chinese, is another name for the red panda.

In fact, Mozilla launched a website called “Firefox Live” in November
2011 to educate and raise awareness of the endangered red panda species.

Live videos of three baby red pandas, Bernadette, Dolly, and Winston,
that were sheltered at the Knoxville Zoo, were streamed on the Firefox Live
website until March 2012. When the babies reached maturity they were
sent to breed and become part of the animal families at the Virginia Zoo
(Norfolk, Virginia) and the Zoo Boise (Boise, Idaho). Subsequently, the
Firefox Live website was retired.

If you'd like to find a red panda in a zoo near you, go to http://
redpandanetwork.org/red_panda/find-a-red-panda-near-you/

Photo: http://churchm.ag/firefox-logo/
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saving the red

panda...

he Red Panda Network saves

wild red pandas, the only species
of its kind in the world, and preserves
their habitat through the empow-
erment of local communities by
adaptive community-based research,
education, and carbon mitigation.
Read more about these endangered
animals (that we were familiar with
before we knew what they were) and
the methods that are being used to
increase their population at http://
redpandanetwork.org/. The organi-
zation is also on Twitter, @RedPan-
daNetwork, and Facebook, https://
www.facebook.com/redpandanetwork

Photo: Red Panda Network

Red pandas are small tree-dwelling

animals native to the eastern Hi-
malayas and southwestern China.
Slightly larger than a domestic

cat and with markings similar to

a raccoon, red pandas have soft,
dense reddish-brown and white fur.
Although red pandas are protected
by national laws in their range
countries, their numbers in the
wild continue to decline because of
habitat loss, poaching and inbreed-
ing due to habitat fragmentation.



by Steve Costello, President/Editor
Boca Raton Computer Society, Inc.

I n the course of going through

more than 200 news feeds, I often

run across things that I think
might be of interest to other user
group members. The following are
some items I found interesting during
the month of September. (Available
on Steve’s blog at http://ctublog.
sefcug.com —LG)

Should You Buy Computer
Hardware Locally Or On The
Internet?
http://www.ghacks.net/2013/09/16/buy-
computer-hardware-locally-internet/
This post gives some pros and cons of
local vs. internet shopping.

Windows XP Users: Here Are Your
Upgrade Options
http://www.howtogeek.com/172243/
windows-xp-users-here-are-your-up-
grade-options/

HTG explains lots of options for
upgrading from XP, for those wonder-
ing what to do when Microsoft stops
supporting XP in April 2014.

Going Paperless: 7 Ways I Use
Reminders In Evernote To Avoid
Embarrassing Myself
http://www.jamierubin.net/2013/09/17/
going-paperless-7-ways-i-use-remind-
ers-in-evernote-to-avoid-embarrassing-
myself/

Some good ideas for using Evernote
reminders. I will be using some of
them myself.

Google Earth For Fishing;
Getting Started
http://www.theonlinefisherman.com/

INTERNET

internet finds

how-to-all/209-find-/6473-google-
earth-for-fishing-getting-started

A use for Google Earth I had not
thought of. If you are a fisherman,
and a techie, this will be very useful.

10 Ways To Use Your Cloud
Storage That You May Not Have
Thought Of
http://www.makeuseof.com/tag/1o-
ways-to-use-your-cloud-storage-that-
you-may-not-have-thought-of/
MakeUseOf shows some ways to use
your cloud storage.

You Can Now Lock Your Device
With Android Device Manager
http://www.ghacks.net/2013/09/24/
can-now-lock-device-android-device-
manager/

A little more security for you Android
device.

Secure Your Facebook Account In
Six Easy Steps
http://howto.cnet.com/8301-11310_39-
57003812-285/secure-your-facebook-

account-in-six-easy-steps/

You can never have too much security
in Facebook. Make sure only the ones
you want to see things see them.

From PC To HDTV Via

Google’s Chromecast
https://windowssecrets.com/top-story/
from-pc-to-hdtv-via-googles-chrome-
cast/

From the Windows Secrets September
25, 2013 free newsletter, an overview of
Google Chromcast device.

10 Types Of System Tools And
Optimization Programs You Don’t
Need On Windows
http://www.howtogeek.
com/172839/10-types-of-system-tools-
and-optimization-programs-you-dont-
need-on-windows/

Don't pay money for things that actu-
ally slow Windows down. I agree with
all they have listed, and other than
using CCleaner, don’t use anything
but what comes with my Windows
operating system.
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MEMBERS’ PAGE

email
addresses

Bollinger, Frank
frbollinger@earthlink.net
Boutwell, Lloyd
Boutwell65@yahoo.com
Covington III, Gary
garyiii@hotmail.com
Gonse, Linda
editor@orcopug.org
Jackson, Walter
wyvjaxn@charter.net
Kaump, LeRoy
leroy_kaump@hotmail.com
Klees, Larry
lklees@dslextreme.com
Leese, Stan
stanleese@dslextreme.com
Loehr, Lothar
lothar@orcopug.org
Lyons, Mike
mike@orcopug.org
Moore, Charlie
charlie@orcopug.org
Musser, Dave
dmusser@worldnet.att.net

JULY 1 Gary Covington Il
AUGUST 1 Sid Liptz
OCTOBER 1  Larry Klees

NOVEMBER 1  Louise Applequist

DECEMBER 1 Bill Bowman,
Bob McDonald,
Carl Westherg

JANUARY 1 Linda Gonse

submitted by Charlie Moore

thank you!

‘ ‘ /e are grateful to our member
presenters: Frank Bollinger,

Bill Bowman, Larry Klees, and Ted

Wirtz. Thank you! And a big thank

We appreciate everyone’s
efforts when they are so very
much needcd.

We need your help, too. Please
contact Lothar Loehr and sign up
to do a presentation.

september
ratfle winners

Requins Screen Saver Value $22
Ann Carnahan Winner
Mixcraft 5 Value $39
Lloyd Boutwelll Winner
Mixcraft 5 Value $39
Leroy Kaump Winner
Manga Studio Value $25
Frank Bollinger Winner
Solar Empire Value $40
Walter Jackson Winner
Pixelmator Value $20
Bob Schmahl Winner

submitted by Charlie Moore

Westberg, Carl you to our Program Chairman, Lo- (g et wel soon, W lthee.
W,cirl@l?rcclop ug-org thar Lochr., who is making arrange- %g PYYY W/
iy €
1thtz@ pachell.net ments for ORCOPUG programs.
Give Your Computer A Gift! JOIN ORCOPUG!
For About $2 A Month You Can Belong to Our User Group!
T T T T T T T T T T T T T T T T T T T T T 71
: New Member (] membership application Renewal” 1 :
| Expired members are not eligible to win raffle prizes or to access the Members’ Only web page. |
| Last Name First Name Nickname |
| |
| Mailing Address City State Zip |
| Home Phone ( ) Work Phone ( ) E-mail Address |
: Areas of Interest/Comments :
| Make checks payable to: ORCOPUG — Dues are $25 per year |
| ORCOPUG, P.O. BOX 716, Brea, California 92822-0716 |
L Meetings are the second Tuesday of every month. See www.orcopug.org for more information. N
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verizon’s plan to
break the internet

erizon...is trying to overturn the Federal Communications Commission’s
Open Internet Order, which prevents Internet service providers from block-
ing, throttling or otherwise discriminating against online content.

And in court last Monday (September 16), Verizon lawyer Helgi Walker made
the company’s intentions clear, saying the company wants to prioritize those web-
sites and services that are willing to shell out for better access. She also admitted
that the company would like to block online content from those companies or
individuals that don’t pay Verizon’s tolls.

In other words, Verizon wants to control your online experience and make the
Internet more like cable TV.

This approach would undermine Net Neutrality, the principle that allows us to
connect and communicate online without interference.

In court last week, the judges asked whether the company intended to favor
certain websites over others.

“I’m authorized to state from my client today,” Verizon attorney Walker
said, “that but for these rules we would be exploring those types of arrange-
ments.”

While Verizon and other ISPs are already raking in immense profits from con-
necting users to the Internet, they see even higher margins in being able to tell us
where to go once we're online. By charging a premium so wealthy businesses can
jump to the front of the line, theyre playing a game with data delivery that would
shove all other sites to the back.

“I think the people who talk about dismantling — threatening — Net
Neutrality don’t appreciate how important it has been for us to have an inde-
pendent market for productivity and for applications on the Internet,” World
Wide Web inventor Sir Tim Berners-Lee has said.

Indeed, Berners-Lee built the World Wide Web on an open protocol that
gives everyday users the power to go wherever they wish.

This approach has given us a truly free marketplace of ideas where even the
smallest entrepreneur can compete with giant corporations. (Would we have
many of the Internet’s most innovative businesses — like Twitter, YouTube and
FourSquare — had they been unable to enter the market on a level playing field?)

The Internet will look a whole lot different if network operators get to favor
one online business or speaker over another. We can’t let the Verizons of the
world turn the Web into their own private fiefdoms where they award express
service to their corporate allies and shunt everyone else to the side.

Verizon has put its cards on the table. Under its preferred scenario, the open
Internet no longer exists. Whatever the outcome of this court case, we need to
fight for policies that protect the open Internet — and stop Verizon’s vision from
becoming reality. (Article excerpts taken from http://www.savetheinternet.com/
blog/2013/09/18/verizons-plan-break-internet)
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USER GROUP DEALS & ANNOUNCEMENTS

secret keyword
raffle for september

he Secret Keyword prize

was not won in Septem-
ber. Two prizes are in the pot.
They are a Totes Emergency
Weather Radio and a Matrix
DVD Lens Cleaner. Look for
the keyword somewhere in this
newsletter or on our website at
WWW.0rcopug.org.

thank you

Allen Wyatt, Bill Sheff, Charlie Moore,
Darry D Eggleston, Don Baker, Gene
Barlow, Ira Wilsker, Judy Taylour, Leo
Notenboom, Linda Gonse, Lothar
Loehr, Marc G. Labreche, Mike Lyons,
Pamela Tabak, Pim Borman, Steve
Costello, Tim O'Reilly

thank you
members!

hank you to member

presenters: Frank Bollinger,
Bill Bowman, Larry Klees, and
Ted Wirtz. And thank you to
Program Chairman, Lothar
Loehr, who arranges our pro-
grams. Won't you please help?
Contact Lothar to sign up.

thank you
2012 vendors!

hank you Acoustica Soft-

ware, At Home, iolo,
Memorex, nik Software, Smith-
Micro, Office Depot, and User
Group Relations for generously
donating products for our 2012
fundraising raffle!
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| Orange County PC e
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member of the association of

_I' computer users helpmg personal computer user groups
—. computer users
ORCOPUG
Post Office Box 716

Brea, California 92822-0716
714-983-2391 ® www.orcopug.org

e Product & “How To”demos

President, Mike Lyons mike@orcopug.org o Free raffles and magazines
Treas/Membership, Charlie Moore charlie@orcopug.org e Help from other members
Editor/Webmaster, Linda Gonse editor@orcopug.org o  Newsletter and web site
Programs, Lothar Loehr /othar@orcopug.org
Membership, Carl Westberg car/@orcopug.org * Special offers & discounts
e Monthly meetings

o Affiliation with worldwide group
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west got together for barn raisings, cattle

roundups, and the occasional party. The

pioneers of new technology get together for
* program of the month ® newsletters ® tech & help installfests, new user training and support,
and just plain fun. Being part of a user

. . group is the best way to get more out of
form ® help & tips ® computer shows ® contact info your computer. and lets you make friends

links ® pdf & on-site search ® map ® online review

e membership application ® Members” Only! page while you're at it.

Tim 0’Reilly, President
0'Reilly Media

where are the meetings, when are they held?
next meeting: Tuesday, October 8, 6 p.m. to g p.m. — Coco’s Bakery Restaurant

egular meetings are held the second Tuesday
of the month at 6 p.m. at Coco’s Bakery
Restaurant, 1011 North Harbor Blvd., Fullerton,
CA. Meetings are free and the public is welcome!

You’ve found the
OCTOBER keyword!

M

askmisterwizard.com

Superior
Cout

Planning meetings are held the second Wednesday after
the regular meeting every month at 6:30 p.m. at Carl’s
Jr., 3240 Yorba Linda Boulevard, Fullerton, CA 92831.
All members are welcome to attend planning meetings!
Check with Charlie Moore in advance to be sure
the Planning meeting has not been cancelled.
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